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Welcome
to the noisy world of Randomwaves



At Randomwaves, 
we believe the best instruments
are the ones you bring to life.

 

Drumboy Pro
is made to be built,

tweaked, and truly yours.



https://github.com/Randomwaves

https://discord.gg/5atevNH6UU



GETTING STARTED

Headphones First

For the best audio experience, plug in your headphones 
before connecting USB power — this helps ensure smooth 
performance with all headphone types.

Best Power Source

For the cleanest signal, ensure your power source is stable. 
Noisy wall adapters can degrade audio quality and cause 
background noise.

Feedback & Support

If you have any questions, encounter any issues, or simply 
want to share your suggestions, you can contact us directly at 
hello@randomwaves.io.



CHARGEPAD

Designed for ultimate mobility, ChargePad is a detachable, rechargeable power dongle that 
serves as the primary power source for your DrumboyPro. It delivers up to 5 hours of 
continuous playtime on a single charge. 

The module features a male USB-C connector that plugs directly into the DrumboyPro to 
supply power, and a female USB-C port for recharging the internal battery. A power switch on 
the top-left corner turns the module on or off. Three integrated LEDs provide real-time status 
updates on battery life and device operation.

Fully Charged
Charging
Low Battery



QUICK START GUIDE

    Insert the Drumboy Pro SD-Card

2. Plug in the Headphones 

3. Connect to Power Supply

4. Power on the Device

5. Access the File Menu
Once the device is on, locate and press 
the [F] key to open the File menu.

6. Load the File Menu
Navigate to the Load tab, select the file 
named File_001 and open it with [O] key .

SD CARD

POWER

USBHPHONE

(connect to either the ChargePad or a power 
source via Usb-C cable)

1.



You can adjust layer playback settings by 
pressing [Layer] key while holding down 
the [M] (mute), [F] (fill), and [P] (playmode) keys.

QUICK START GUIDE

4. M | F | P Keys

7. Reset | Play | Record
On the top left of Drumboy, you have the keys to 
control the song play.

5. Start Finger Drummnig
You can start generating beats by using the 
[Layer] keys.  



In&Out
Interface
Main
Knob Bank
Song Bank

SECTION 01
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Drumboy Pro features a USB-C power port, an SD card slot for data and updates, and an 
STM32 interface for customization. Audio connectivity includes Line In/Out and Headphone 
jacks, while MIDI and Sync I/O ports ensure perfect synchronization with your other devices.



INTERFACE

Drumboy Pro is designed with a clean, user-friendly interface that prioritizes an intuitive 
workflow. To ensure a smooth experience, the diagram below provides a comprehensive 
overview of the device's layout.

RHYTHM
METRONOME
PARAM EQ

FILTER 1
FILTER 2
PEQ

EFFECT 1
EFFECT 2
REVERB

LFO
LAYER INST
LAYER SONG

SONG

FILE
DRUMKIT
RHYTHM

ADD
UP

CLEAR

LEFT
MAIN

RIGHT

COPY
DOWN
PASTE

MUTE
FILL

STYLE

RESET FUNC

KNOB

RESET
PLAY/STOP

RECORD

8 x KNOB

10 x LAYER



MAIN MENU

TEM MEA BAR QUA FL1 FL2 EF1 EF2

120 04 04 08 ON OFF OFF ON

Tempo Bar Filter 1 Effect 1Measure Quantize Filter 2 Effect 2

The Main Menu provides a summary of the song, allowing you to check all global parameters 
at a glance.

Press [III] to enter the Overview Menu

Knob Control 

Exclusively in this menu, the bottom-right knob 
performs your custom assigned function. In all 
other menus, it is used to change the selected 
menu item.



KNOB BANK

Menu Control 

When a menu is active, the bottom-right knob 
automatically controls the active menu item. Upon 
returning to the Main menu, this knob reverts to its 
originally assigned function.

Fast Mode

Hold the [Add] key while turning a knob to engage 
Fast Mode, which doubles the value change rate 
for rapid adjustments.

Select a Bank

To activate a specific bank, press the desired 
[Layer 1-10] key while holding down the [Knob] 
key.

Assign a Function 

To map a function, turn the target knob to select 
the desired parameter while holding down the 
[Knob] key. All assignments are saved instantly 
and recalled upon power-up.

Drumboy Pro features a macro control system using 8 function assignable knobs. The 
device provides 10 knob banks, allowing for a total of 80 assignable functions. You can 
monitor the assigned functions and current values for all knobs at the bottom of the display.
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SONG BANK

Select a Bank

To activate a specific bank, press the desired 
[Layer 1-10] key while holding down the [Song] 
key.

If a bank change is initiated during playback, the 
device will wait until the current song finishes 
before switching to the target bank.

Drumboy Pro is equipped with 5 distinct song banks for each file, allowing for flexible 
arrangements within a single project.



SECTION 02

File
Drumkit
Rhythm



NEW

Opens a new file.
(Press O to select)

LOAD

Loads the selected
file.
(Press O to select)

SAVE

Saves the current work 
to the selected file.
(Press O to select)

CLEAR

Clears the contents of 
the selected file.
(Press O to select)

NEW LOAD SAVE CLEAR

SELECT FILE_001 FILE_001 FILE_001>
FIL

FILE MENU

You can reset, load, save and delete the files you have created using the File Menu. The file 
library consists of 100 files and is stored in the System/File folder on the SD card.

MENU UP

MENU DOWN

MENU
RIGHT

CANCEL

MENU
LEFT

SELECT

Press [F] key to enter the File Menu

Layer Song, Layer Instrument, Lfo, Rhythm, Eq, Filter, Effect and Reverb settings are stored in each File. 

Indicates whether the file is full or empty



NEW LOAD SAVE CLEAR

SELECT DRUM_001 DRUM_001 DRUM_001>

NEW

Opens a new drumkit.
(Press O to select)

LOAD

Loads the selected
drumkit.
(Press O to select)

SAVE

Saves the current work 
to the selected drumkit.
(Press O to select)

CLEAR

Clears the contents of 
the selected drumkit.
(Press O to select)

DRU

DRUMKIT MENU

You can reset, load, save and delete the drumkits you have created using the Drumkit Menu. 
The drumkit library consists of 100 drumkits and is stored in the System/Drumkit folder on the 
SD card.

MENU UP

MENU DOWN

MENU
RIGHT

MENU
LEFT

Press [D] key to enter the Drumkit Menu

Layer Instrument, Lfo, Eq, Filter, Effect and Reverb settings are stored in each Drumkit. 

Indicates whether the file is full or empty

CANCELSELECT



RHYTHM MENU

You can define the structural and timing elements of your song using the Rhythm Menu. 
Changing bar, measure & quantize settings, make permanent adjustments to the timing of the 
beats in the song and cannot be undone.

MENU UP

MENU DOWN

MENU
RIGHT

UNLOCK
(LONG PRESS)

MENU
LEFT

Press [R] key to enter the Rhythm Menu

Press and hold Unlock key to edit the parameters

TEMPO

RHY
BAR MEASURE QUANTIZE

120 04 04 1/16

TEMPO

Tempo of the song

60 < Tempo < 160

BAR

Number of beats 
in each measure

1 < Bar < 8

MEASURE

Number of measures 
in the song

1 < Measure < 8

QUANTIZE

Grid value of the 
quantization

1/64 < Quantize < 1/1

LOCK
(LONG PRESS)

>



SECTION 03

Amp
Metronome
Sync



AMP MENU

ACTIVE

Enables/disables 
filter channel.

TYPE

Filter
Type

RES

Filter
Resonance

Press and hold Mute/Unmute keys to control audio channels

FREQ

Filter
Cutoff
Frequency

SLOPE

Filter
Slope

MASTER HP

ON 1K FIL1 LR ON00LPF

LO

DBDBVOL DB

MUTE

BYP LR ACT

LI LI PAN NOR

>

DRY

Dry Signal
Level

WET

Wet Signal
Level

AMP

You can adjust the global, headphone, line out, and line in levels, set the line in pass mode, 
and configure pan and normalize values using the Amp Menu.

MENU UP

MENU DOWN

MENU
RIGHT

MENU
LEFT

Press [METRO] key to enter the Metronome menu

UNMUTE
(LONG PRESS)

MUTE
(LONG PRESS)

MUTEMUTE



METRONOME MENU

You can activate metronome, define its precount state, sample sound and volume level 
using the Metronome Menu.

MENU UP

MENU DOWN

MENU
RIGHT

MENU
LEFT

Press [METRO] key to enter the Metronome menu

MET
ACTIVE PRECOUNT SAMPLE VOLUME

ON ON KNOCK 075>

ACTIVE

Enables/disables 
metronome while 
recording

PRECOUNT

Enables/disables 
precount before 
recording

SAMPLE

Metronome 
sample sound

VOLUME

Metronome
volume level



SYNC MENU

MENU UP

MENU DOWN

MENU
RIGHT

MENU
LEFT

Press [SYNC] key to enter the Sync Menu

MIDI IN

SYN
MIDI OUT SYNC IN SYNC OUT

OFF OFF OFF OFF

MIDI IN

Midi In channel
selection

01 < Channel < 16

MIDI OUT

Midi Out channel
selection

01 < Channel < 16

SYNC IN

Sync In mode
selection

SYNC OUT

Sync Out mode
selection

>

You can configure the device's connectivity properties by adjusting the MIDI settings and 
synchronization options using the Sync menu.

CHA MOD MODCHA



MIDI IN | OUT

To synchronize Drumboy with another device via midi, follow these steps:

For Midi_In Mode:
In the Sync Menu, set the Midi_In option to preffered midi channel (1-16).
Connect a mono/stereo cable to the Midi_In port of the device.
(C -> Layer 01, C# -> Layer 02, D -> Layer 03, D# -> Layer 04, E -> Layer 05, 

F -> Layer 06, F# -> Layer 07, G -> Layer 08, G# -> Layer 09, A -> Layer 10)

For Midi_Out Mode:
In the Sync Menu, set the Midi_Out option to prefered midi channel (1-16).
Connect a mono/stereo cable to the Midi_Out port of the device.
(Layer 01 -> 36, Layer 02 -> 37, Layer 03 -> 38, Layer 04 -> 39, Layer 05 -> 40, 

Layer 06 -> 41, Layer 07 -> 42, Layer 08 -> 43, Layer 09 -> 44, Layer 10 -> 45)

MASTER SLAVE

Midi Out Connection Midi In Connection



To synchronize two Randomwaves devices, follow these steps:

For the master device:
In the Sync Menu, set the Sync_Out option to Mode_RW.
Connect a stereo cable to the Sync_Out port of the master device.

For the slave device:
In the Sync Menu, set the Sync_In option to Mode_RW.
Connect the other end of the stereo cable to the Sync_In port of the slave device.

In Sync Mode, only the play buttons on the master device will be active.

You can synchronize more than two devices using the aforementioned principle.

SYNC IN | OUT

InactiveActive

MASTER SLAVE

Sync Out Connection Sync In Connection



SYNC IN | OUT

Drumboy does not operate in a step sequencer format. It can only be synchronized as a 
master device with third-party devices. To synchronize Drumboy as master, follow these 
steps:

For the master device: (Drumboy)
In the Main Menu, set the Sync_Out option to Mode_ST.
Connect a mono/stereo cable to the Sync_Out port of the master device

For the slave device: (Third Party)
Make the necessary settings for the device to function as a slave.
Connect the other end of the mono/stereo cable to the Sync_In port of the slave device.

You can synchronize more than two devices using the aforementioned principle.

Active

No Sync_In Option

MASTER SLAVE

Sync Out Connection Sync In Connection



SECTION 04

Eq
Filter
Effect
Reverb



ACTIVE

Enables/disables 
parametric eq.

LOW SHELF

Frequency & gain of 
low shelving filter.  

PEAK

Center frequency, gain 
and quality factor of 
peaking filter.

HIGH SHELF

Frequency & gain level 
of low shelving filter.  

PARAMETRIC EQ MENU

MENU UP

MENU DOWN

MENU
RIGHT

MENU
LEFT

TOGGLE

Press [EQ] key to enter the Eq menu

You can activate parametric eq, define its filters’ center frequency, gain & quality factor 
using the Parametric Eq Menu. You can use the [Toggle] key to switch between frequency, 
gain and Q values.

ACTIVE LS

HZ
DB

Q
HZ
DB

Q
HZ
DB

Q
HZ
DB

Q
HZ
DB

HZ
DBON

P P P P HS

+04
50

+02
100
01

+00
250
01

+00
1K
01

-02
3K
01

-04
5K

PEQ

Indicates smooth transition during eq parameter changes.

PASS



ACTIVE

Enables/disables 
filter channel.

TYPE

Filter
Type

RES

Filter
Resonance

Indicates smooth transition during filter parameter changes.

FREQ

Filter
Cutoff
Frequency

SLOPE

Filter
Slope

PASSACTIVE TYPE

ON 1K 12 00 10000LPF

FREQ

HZ % DB % %

RES SLO DRY WET

>

DRY

Dry Signal
Level

WET

Wet Signal
Level

01

FILTER 1-2 MENU

MENU UP

MENU DOWN

MENU
RIGHT

MENU
LEFT

Press [FIL] keys to enter the Filter menus

FIL

You can activate filters, define its type, center frequency, resonance, slope and dry&wet 
levels using the Filter Menu.



ACTIVE

Enables/disables 
effect channel.

ACTIVE TYPE

ON 08 00 25 7501BIT

RESO

BR % DB % %

SAMP THRE DRY WET

>

PASS

TYPE

Effect
Type

DRY

Dry Signal
Level

WET

Wet Signal
Level

01

EFFECT 1-2 MENU

MENU UP

MENU DOWN

MENU
RIGHT

MENU
LEFT

Press [EFF] keys to enter the Effect menus

EFF

Indicates smooth transition during effect parameter changes.

You can activate effects, define its type, parameters and dry&wet levels using the 
Effect Menu.



EFFECT 1-2 MENU

ACTIVE TYPE

ON 50 25 100 5005DEL

TIME

% % % % %

LEV FEED DRY WET

>

ACTIVE TYPE

ON 10 1.0 75 7525CHO

TIME

% HZMS % %

FEED RATE DRY WET

>

ACTIVE TYPE

ON 2.5 1.0 75 7525FLA

TIME

HZ % %

FEED RATE DRY WET

>

ACTIVE TYPE

ON 1K 1.0 100 505KPHA

STAR

HZ HZ HZ % %

END RATE DRY WET

>

DELAY Delay 
Level

Dry Signal
Level

Delay
Time

Delay 
Feedback

Wet Signal
Level

CHORUS Chorus
Feedback

Dry Signal
Level

Chorus
Delay
Time

Chorus
Rate

Wet Signal
Level

FLANGER Chorus
Feedback

Dry Signal
Level

Flanger
Delay
Time

Chorus
Rate

Wet Signal
Level

PHASER Phaser
End Freq

Dry Signal
Level

Phaser
Start Freq

Phaser
Rate

Wet Signal
Level

MS %

EFF

EFF

EFF

EFF



ACTIVE TYPE

ON -06 01 100 10004COM

THRE

DB X MS MS %

RATE ATT REL MIX

>

ACTIVE TYPE

ON -12 01 500 10004EXP

THRE

DB X MS MS %

RATE ATT REL MIX

>

ACTIVE TYPE

ON 12 5K 25 100-06OVE

GAIN

DB DB HZ % %

THRE TONE DRY WET

>

ACTIVE TYPE

ON 12 5K 25 75-06DIS

GAIN

DB DB HZ % %

THRE TONE DRY WET

>

COMPRESSOR Comp.
Rate

Comp.
Release
Time

Comp.
Threshold

Comp.
Attack
Time

Wet Signal
Mix

EXPANDER Expander
Rate

Expander
Release
Time

Expander
Threshold

Expander
Attack
Time

Wet Signal
Mix

OVERDRIVE Overdrive
Threshold

Dry Signal
Level

Overdrive
Gain

Overdrive
Tone

Distortion
Threshold

Distortion
Gain

Distortion
Tone

Wet Signal
Level

DISTORTION Dry Signal
Level

Wet Signal
Level

EFFECT 1-2 MENU

EFF

EFF

EFF

EFF



ACTIVE SIZEPASS

ON 50 25 100 500525

DEC

%% MS % % %

PRE SUR DRY WET

>

ACTIVE

Enables/disables 
parametric eq.

SIZE

Room
Size

PRE

Pre-delay 
Time

DRY

Dry Signal
Level

DEC

Decay
Level

SUR

Surround
Level

WET

Wet Signal
Level

REVERB MENU

MENU UP

MENU DOWN

MENU
RIGHT

MENU
LEFT

Press [REV] key to enter the Reverb menu

You can activate reverb, define its room size, decay level, pre-delay time, surround level 
and dry&wet levels using the Reverb Menu.

REV

Indicates smooth transition during effect parameter changes.



SECTION 05

Lfo
Layer Inst
Layer Song
M F P



LFO MENU

MENU UP

MENU DOWN

MENU
RIGHT

MENU
LEFT

Hold [L] and press [Layer] to enter the LFO menu

PASTECOPY

LFO

Drumboy Pro features 10 global LFOs that function independently of the layers. You can 
activate these LFOs and configure their settings using the LFO Menu. To apply the 
modulation, you must assign the configured LFO to a target parameter within the desired layer 
instrument. 

ACTIVE

ON 1/1 00 100SIN

CUR BAR DEG %

TYPE RATE PHA DEP

>

ACTIVE

Enables/disables 
Lfo.

GRAPH

Lfo Graph

TYPE

Lfo Type

RATE

Lfo Rate

PHASE

Lfo Phase

DEPTH

Lfo Depth

You can copy an LFO to another by long-pressing the copy and paste buttons.



LAYER INST MENU

MENU UP

MENU DOWN

MENU
RIGHT

PASTE

MENU
LEFT

SELECT /
TOGGLE

COPY

You can define instrument & sample type and configure its parameters and bypass 
settings using the Layer Inst Menu.You can assign the desired global LFO to any of the 
sample's parameters.

INSTRUMENT

Instrument type of the 
selected layer
(Press [O] to select)

SAMPLE

Sample type of the 
selected layer
(Press [O] to select)

SAMPLE

ALTAIR 1.00 FORW ON0.75

0001

44KHZ-24-M -- -- -- --

LEV PIT DIR RES ><

>

Press [O] to switch to LFO selection

Sample
Level

Sample 
Play
Speed

Sample
Play
Direction

Sample
Play
Resolution

INS
INST

BASS

000101

INST MENU 1

You can copy an inst to another by long-pressing the copy and paste buttons.

Hold [I] and press [Layer] to enter the Layer Inst menu



LAYER INST MENU

Sample
Play
Start Point

Sample 
Play
End Point

Sample
Play
Timing

Sample
Play
Probability

INST MENU 2

INST MENU 3

Press [O] to switch to LFO selection

Eq
Pass

Filter
Pass

Effect
Pass

Reverb
Pass

>
INS

INST

BASS

000101

100 00 10000

-- -- -- --

STA END TIM PRO ><SAMPLE

ALTAIR

0001

44KHZ-24-MINS
INST

BASS

000101

>
INS

INST

BASS

000101

1+2 1+2 ONON

EQ FIL EFF REV ><SAMPLE

ALTAIR

0001

44KHZ-24-MINS
INST

BASS

000101

There are 3 layer inst menus. You can switch between them by navigating left or right, or by 
pressing the [Layer] key while holding the [I] key.



LAYER SONG MENU

MENU UP

MENU DOWN

MENU
RIGHT

CLEAR
(LONG/SHORT)

MENU
LEFT

ADD
(LONG/SHORT)

PASTE
(LONG/SHORT)

COPY
(LONG/SHORT)

>

FILL

BASIC_01

01 | 0401 TIM

ASCSTD

LEV

SON

You can copy a song to another empty layer by long-pressing the copy and paste buttons.

S E

You can arrange the beats for each layer, define the associated fills, and adjust the fill 
parameters directly via the Layer Song Menu.

FILL

Fill type of the 
selected beat.

TIM

Fill timing 
mode

LEV

Fill level 
mode

GRAPH

Fill Graph

Hold [S] and press [Layer] to enter the Layer Song menu

[ Control timing and level with the 2 bottom-right knobs ]



LAYER SONG MENU

The chart below presents an in-depth overview of each key, highlighting their specific roles 
and functionalities in the Layer Song Menu.

ADD

Long press of the Add key adds repeated beats 
on empty layers. The intensity of the beats 
increases with the length of the key press.

LEFT / RIGHT

You can use the left&right keys to navigate 
between beats, or hold the Add key to shift 
them.

UP / DOWN

You can select the fill type of the selected beat 
using the up and down keys.

CLEAR

Short press of the Clear key clears 
the selected beat, long press clears the whole 
layer.

COPY

Short press of the Copy key copies 
the fill of the selected beat, long press copies 
the beats of the whole layer.

PASTE

Short press of the Paste key pastes 
the copied fill to the selected beat, long press 
pastes the beats to the selected empty layer.



M | F | P KEYS

You can instantly adjust layer playback settings using the M, F, and P keys. The M key 
enables or disables the mute function, the F key toggles fill playback on or off, and the P key 
activates or deactivates the playmode settings (such as pitch, direction, and resolution).

Mute 

Fill 

PlayMode

M + Layer

F + Layer 

P + Layer

Press [Layer] while holding down M | F | P keys



SECTION 06

Sd Card
Firmware



SD CARD FORMAT

On your SD Card, you will find two primary folders: System and Sample.

System Folder:
This folder contains all the essential files necessary for the operation of the Drumboy software. 
It is crucial not to delete or modify any files within this folder, as they are required for the 
proper functioning of your device.

Sample Folder:
Within this folder, you will see various subfolders, each categorized by different instruments.
You can organize and store your desired samples (.wav, 8-32 bit, mono-stereo) within these 
instrument subfolders. 

Instrument Sample
System

Sample Bass Apollo_1.wav

Apollo_2.wav

Apollo_3.wav

You can download all SD Card files from www.randomwaves.io whenever you require them.

SD Card



UPDATE FIRMWARE

To update your Drumboy firmware, follow these steps:

Visit www.randomwaves.io website and download the latest Drumboy firmware.

Turn off your Drumboy device to ensure it is safely powered down.
Carefully remove the SD card from the device.
Connect the SD card to your computer, then locate the root directory of the SD card.
Copy the downloaded Drumboy firmware to this root directory.
Safely eject the SD card from your computer and re-insert it into your Drumboy device.
Power on your Drumboy device. 

The device will automatically detect and load the new firmware.

System Folder

SD Card

Sample Folder

Drumboy_Fw_01_01.bin



CUSTOMIZE FIRMWARE

ComputerSTLink V2

To customize your Drumboy Pro firmware, follow these steps:

Visit www.randomwaves.io website and download the latest Drumboy source code files.
Install STM32CubeIDE to your computer and open Drumboy project folder in this software.

Wire the SWDIO, GND, and SWCLK pins from the DrumboyPro to the matching pins on the 
STLink V2. Once connected, plug the STLink V2 into your computer's USB port.

You are ready to upload your customized firmware to Drumboy.



For any questions or suggestions, 
feel free to email us at hello@randomwaves.io.

Stay musical!



Randomwaves © 2026. All rights reserved.


